CONTENTdm Basic Skills 2: Working with

Textin CONTENTdm
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Build a digital collection

Add a collection

Configure the collection

Create a project in the Project Client
Configure the project

Add digital items and/or objects

Approve items/objects and index collection
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Compound object types

o Postcard — front and back images of two-sided items (e.g., tickets, baseball cards)

¢ Document — sequential pages of a report, a journal, a photo album, etc.

¢ Monograph — retain the hierarchical structure of documents, including chapters, sections,
and pages

¢ Picture Cube — select up to six images to link together views of a 3-dimesional object

Configure or reconfigure a collection for text
1: Metadata fields

l:. CONTENTdm Administration

Current cnllectinn:l Mindy National Wildiife |+ | [T 20

Metadata fields

View and configure collection and administrative fields.

Collection field properties

View, add, edit and delete fields. Enable full text searching and controlled vocabulary. After you have added, changed, or deleted fields, index the collection to
update changes.

Field name DC map Data type rge Search Hide Required Vocab add field

edit | delete
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1 Title Title Text No Yes No Yes No
No
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To edit metadata fields for this collection
e Under collections tab, click the fields link
e View, add, edit, or delete metadata fields
o To add new metadata field
= Click add fields
= Enter data for the new field
= Click Save changes to add new field
o To edit existing metadata field
= Click edit next to the desired field to modify
= Edit the field
= Click Save changes to update
o To delete existing metadata field
= Click delete next to the desired field to remove
= Click Yes to confirm OR cancel
¢ Use the move to drop-down menu next to each field to re-order metadata fields
e Index the collection to update changes to metadata fields. To index the collection:
o Click items tab
o Click index
o Under Index scheduler, click index now

2: Data type — Full Text Search

Only one metadata field per collection may have a data type of full text search.

Collection field properties

View, add, edit and delete fields. Enable full text searching and controlled vocabulary. After vou have added, changed, or deleted fields,
index the collection to update changes.

Field name DC map Data type Large Search Hide Required Vocab add field
1 Title Title Text Mo Yes Mo Yes MNo edit | delete
2 Subject Subject Text No Yes Mo Mo MNo edit | delete
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is 6 miles from here. South East & 9 m. from Nerthrop. Fine roads as level as a floor & about 35 min. run on a bike

You will be 2 miles fromKii@SBUEGIon a main road. Mail route & telephone. There is a 3 room house, large new barn, hen houses, cow shed & tool shed. All trays sweat boxes & farming
implements, mower & rake go with the place also two Black mares & work harness. The mares are 16 years old and yud & yentel (good & gentle) 17 acres peaches 12 acres Muscat Vines 7a
alfalfa & 3 acres Gum trees, 1 ac farm yard & buildings. You wil need to buy a cow



Compound objects - file organization

1: Postcards

Only two image files can be imported for postcards
Transcript files are optional—can be one or two transcript files (.txt)

Root file names for images must match optional transcript files

All image files will be in one folder (or directory) and transcript files in its own folder (or
directory)

b

Paris Postcard
JPEG
TIFF
TXT

2: Documents

Transcript files are optional—can be one or two transcript files (.txt)

Root file names for images must match optional transcript files

All image files will be in one folder (or directory) and transcript files in its own folder (or
directory)

Image File Name

Transcript File Name

paris1.jpg

paris2.jpg

paris2.txt

= ) Bell Handwritten Letter

I G
) Text
I Tiff

3: Monographs

Organize image files to reflect the hierarchy of the monograph (e.g., images of chapters
or sections in its own folder/directory
All optional transcript files can be together in a separate folder/directory, but outside the
hierarchy of the monograph

Image File Name Transcript File Name
bell1.tif bell1.txt
bell2.tif bell2.txt
bell3.tif bell3.txt

Folders
= ) Sample
# (=3 Bel Fosteard
& (03 chid's Chair
= (23 History of the Ohio Canals

* () Chapter 1
&1 Chapter 2
#{C3) Chapter 3
-7 Chapter 4
* () Chapter 5
# ) Chapter &

13 Transcripts
# I3 Spring 1994, No. 4

* ) Seanna

# |2 shane

# { Support

&) Tavares

H (3 TestMedia

#-) Traning

2| 0002 _Inside Cover.TIF
(=) 0003 _tap. TIF

3] 0004 _Elank Page. TIF
5] 0005 _Introductory Mote. TIF

2| 0006 _Blank Page. TIF

\

Folders
=R ]

1210007 _Table of Contents. TIF ¥

53] 0009_Table of Contents, TIF
53] 0010_Table of Contents, TIF
1] 001 1_History of the Ohia Can..

imua_rable of Contents. TIF

5] 001 2_Blank Page. TIF

3] 0013 _Preface.TIF

e Iy Saction 1
History of the Ohio Canals 01 _Page 1S.TIF
() Chapeer 1 [B)0z_rage 16.11F
(@] Chapter 2 | [2)03_Page 17.TIF
() Chapker 3 04_Page 18.TIF
0 Chapter 4
i) Chapter 5
i) Chapter &
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Project Client: Import compound objects

1: Create a new project

) CONTENTdm Project Client - x
Project | Add lte Edit Administration  Help

[ New ¢ S—

et Project Client
Edit Project
Getting started - Building your collections

To start adding items to a collection or to edit items already in a collection, create a project or import a shared project created by another user on your shared network.

Exit

Open your Project Client

Click Project menu, then select New

Enter the URL for your library’s CONTENTdm server.

Enter your logon credentials to the server. Click Next

Select the collection to associate with this project. Click Next
Enter a name for the project

Click Finish to create the new project

NGOk WN =

2: Configure the project

Use the Project Setting Manager to configure your project.

Click the tab with the name of the current project

Click the Project menu

Select Project Settings Manager

Select the setting you wish to configure

e General settings: contains information about the project and the collection to which
it is contributing items; can export these setting for use in other projects

¢ Metadata templates: use to streamline adding metadata to items imported into the
project

e Metadata field types: contains information about how the metadata fields are
defined for the collection

¢ Images & thumbnails: use to modify the size and type of your display images;
create watermarks, brands, and bands

e Image rights: use to configure the display of copyright information or indicate
ownership of items in the collection; must be configured before importing items

e Processing and OCR: use if you want to create fully searchable text

e Project options: use to configure how upload items in the project to the collection
on the server; use and setup the spell checker

¢ Find in Collection: useful for maintaining already-built collections

BN =

®ocLc



3: Add compound objects

To add digital files to the project:
1. Click the Add menu
2. Select Compound Objects
Note: use to add multiple related files (e.g., pages in a document, audio files on a CD,
postcards, etc.)
3. Add using Compound Object Wizard. Click Add

Import Objects | Map Fields |

|Add using [Cumpcund Object Wizard j Add J | Help me choose. . .
Compound Directory Scan Cor.ﬂpouhd Page Cornpound
L Object Type | Structure | Directo Soea Metadata | Ot fem e
Y L 2 Metadata Record
E O El

4. Select the type of compound object to create. Click Next

Single Compound Object - Choose Type s

Import files to create a compound object
What type of compound object would you like to create?
@# Document. Document with no hierarchy.

" Monograph. Document with hierarchy, such as chapters in a book.
" Picture Cube. Object with six views, such as statues or buildings.

" Postcard. Object with two sides, such as a postcard or baseball card.

Browse to folder/directory to locate the desired image folder to add

Select the desired folder. Click Next

Select Yes to generate display images. Click Next

Select Page Information, including page names and location of transcripts. Click Next

Single Compound Object - Page Information x

© N O

Specify page names
& Use file names as titles
I Ignore information before underscore. Example: 001_Page1 becomes Pagel

" Label pages using sequence

Name: Begin with ’_

€ Label pages using tab-delimited text file
Transcript
€ Import transcript files from a directory

Directory name:

" Generate transcripts using OCR

@ No transcripts

9. Click Finish to add compound object
10.Click Close to dismiss the Summary Screen
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To view and edit the digital objects after they have been imported to the project:
1. In the project spreadsheet, double-click to open a compound object
2. Edit the object and items metadata
a. View Structure — use the left-navigation to display and edit metadata for the
object and each item in the compound object
b. View Thumbnails — use the thumbnails to display and edit metadata for the
object and each item in the compound object
c. View Spreadsheet — display the object and each item in the compound object in
a spreadsheet view for editing
3. Click Save at the top of the editor to save changes

To upload digital objects to the collection on the server:
1. In the project spreadsheet, select each object to upload (or use select all to select all
objects)
2. Click Upload for Approval at the top of the project spreadsheet
3. Fix any errors and select those items to Upload for Approval again

Approve objects/items and index the collection

To approve items uploaded to the collection:
1. In the Project Client, click Administration menu
2. Select approve (Note: This open to the approval page of CONTENTdm Administration)
3. (Optional) Can select to Approve all or Approve and Index All
4. Select individual items or select all to approve
5. Click go

To index the collection:
1. In CONTENTdm Administration, click the items tab
2. Click index
3. Under Index Scheduler section, click Index Now to index the collection immediately
OR
4. Schedule the index
o Select Once on to schedule the index process to run on a specified date and time
o Select Recurring at to specify day(s) and time for the index process to run more
than once
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PDF files

PDF characteristics

e |deal file format for documents initially created as digital documents (e.g., dissertations)

e Notideal file format for scanned images because scanned items do not automatically
contain embedded text

e Adobe Acrobat Reader required to read PDF files

PDF files in CONTENTdm

e A PDF file can be treated as
o Single file
o Compound object

e An advantage to converting a PDF file to a compound object is that each page of the PDF
becomes a page with its own metadata record.

Add PDF files

1: Add PDF as a single item:

e Under Project Settings Manager, select Metadata templates
o Configure PDF metadata template, as needed

e To add a single PDF file

Click the Add menu

Select Item

Browse to folder/directory to locate the desired file to add
Select the desired file

Click Add to import the file into the project

o Click Close to dismiss the Summary Screen

0O O O O O

2: Add PDF as a compound object:

e Under Project Settings Manager, select Processing
o In PDF File Conversion section, select convert PDF to compound objects

e To add a single PDF file

Click the Add menu

Select Item

Browse to folder/directory to locate the desired file to add
Select the desired file

Click Add to import the file into the project

Click Close to dismiss the Summary Screen

O O O O O O
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Support and Resources

Community

e Community Center
http://www.oclc.org/community/home.en.html

Support & Training

e Documentation
CONTENTdm

e Training (includes instructor-led sessions, recordings, tutorials)
CONTENTdm training

Office Hours

e Details for access code and call-in numbers: Office hours

Contact Customer Support
e United States: 1-800-848-5800 or support@oclc.org

e Inyour region: OCLC Support in your region



http://www.oclc.org/community/home.en.html
https://help.oclc.org/Metadata_Services/CONTENTdm
https://help.oclc.org/Metadata_Services/CONTENTdm/CONTENTdm_training
https://help.oclc.org/Metadata_Services/CONTENTdm/Get_started/020CONTENTdm_technical_office_hours
mailto:support@oclc.org
https://help.oclc.org/Librarian_Toolbox/Contact_OCLC_Support/Contact_OCLC_Support_in_your_region

	1: Metadata fields
	2: Data type – Full Text Search
	1: Postcards
	2: Documents
	3: Monographs
	1: Create a new project
	2: Configure the project
	3: Add compound objects
	Approve objects/items and index the collection

